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1. Introduction 
The Lantronix Workbench application provides an interface between your personal computer and 
Lantronix devices which allows you to connect to the devices, configure and manage them, and 
collect data from them for evaluation. This document describes how to setup and run the 
Workbench application. 

Lantronix Workbench supports the following Lantronix devices: 

• FOX3 Series 

• FOX4 Series 

• BOLERO40 Series 

Read the latest product documentation before you use the above-mentioned Lantronix devices or 
upgrade the firmware of the devices. Refer to chapter 2. Related Documents. 
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2. Related Documents 
The table below lists related user documents and application notes.  

NR Document Description 
[1] PFAL Command Reference Contains the description of the internal firmware and 

the complete list of supported PFAL commands used 
to manage/administer an application built on the FOX3, 
FOX4 and BOLERO40 series devices. 

[2] FOX3 Series - Hardware Manual Contains information about the hardware of FOX3-
2G/3G/4G devices. 

[3] FOX3 Series Promotion Kit – User 
Guide 

Provides customers information about the FOX3-
2G/3G/4G PROMOTION-KIT, to evaluate the product 
and all its functionality. 

[4] FOX4 Series – Hardware Manual Contains information about the hardware of FOX4-4G 
devices. 

[5] FOX4 Series Promotion Kit – User 
Guide 

Provides customers information about the FOX4-4G 
PROMOTION-KIT, to evaluate the product and all its 
functionality. 

[6] BOLERO40 Series Hardware Manual Contains information about the hardware of 
BOLERO40 series devices. 

[7] BOLERO40 Series Promotion Kit User 
Guide 

Provides customers information about the BOLERO40 
series PROMOTION-KIT, to evaluate the product and 
all its functionality. 

[8] Application Note: Remote Firmware 
Update with Workbench Software 

Contains instructions to upgrade AVL devices to a new 
firmware version remotely via TCP (server-based 
application). 

Table 2-1: Related Documents 

For the latest user documentation, visit https://www.lantronix.com/technical-
support/documentation/user-guides/. 

For Application Notes, visit https://www.lantronix.com/resources/app-notes/. 

 
  

https://www.lantronix.com/technical-support/documentation/user-guides/
https://www.lantronix.com/technical-support/documentation/user-guides/
https://www.lantronix.com/resources/app-notes/
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3. Running the Workbench Application 
Requirements: 

• PC with Intel Core i3 or advanced processor and Windows 10/11, MacOSX, or Linux 
operating system installed. 

• 512 MB of RAM or higher (512MB minimum supported; may limit performance and some 
features). 

• 300 MB of available hard disk space (recommended 8 GB). 
• Keyboard and Mouse. 

To run the Lantronix Workbench application on a PC with Windows 10/11 Operating System: 

1. To download the Workbench software, go to 
https://www.lantronix.com/products/workbench/.  

2. Extract the contents of the zip file. 

3. Open the folder and double-click start_workbench file. The Load profile dialog box 
displays.  

4. Click in the Profiles window, the dropdown displays the available profiles. Select Default 
Empty and click OK. 

 
Note: The Workbench application allows you to save your work as a profile. A profile is a 
collection of Workbench views. Each time you start the application, you can load the required 
profile. For more information on profiles refer to chapter Profiles. 

5. The Workbench application is launched, and the UI displays. 

 
Figure 3-1: Workbench User Interface 

https://www.lantronix.com/products/workbench/
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4. Workbench Interface Overview 

Navigating the Interface 
The Workbench interface consists of the following sections: 

• Application Menu 
• Application Toolbar 
• Workspace 
• Connection View 

 
                                                Figure 4-1: Workbench Interface 

Application Menu 
The application menu provides access to the various features provided by the application. It 
contains the following: 

• Plugins – Contains different views that allow you to perform tasks related to the Lantronix 
devices 

• File – Provides access to Workbench settings and saving profiles 

• Window – Allows you to toggle the interface window 

• Workbench – Provides access to profile options 

• Help – Provides access to help documentation 
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Application Toolbar 

Figure 4-2: Application Toolbar 

The application toolbar contains icons to open Views on the workspace. Each View performs a 
certain function related to the device.  

• Port – Opens Port view. Use it to set up connection with the device 

• Terminal – Opens Terminal view. It displays messages sent by the device and allows 
you to send messages to the device 

• Editor – Opens Editor view. Use it to read and manage the current device configuration 

• History – Opens History view. Use it to download GPS data saved inside the target 
device to a file 

• Firmware - Opens Firmware view. Use it to upload a firmware file for local firmware 
upgrade via serial connection on the target device 

• GPS - Opens GPS view. It displays the GPS details  

• Lantronix Advanced Configuration Service (LACS) – Opens LACS view. Use it to get 
device information and as a chatbot for configuration requests 

• Wizard – Opens Wizard view, displays information about ConfigWizard. Use it to 
configure your device for different functions and automatically generate device 
configuration (PFAL Commands) for each function based on your input 

• Recorder – Opens Recorder view. Use it to log data received from the target device, 
filter the data, and save it to a file. It also allows you to view and evaluate the saved data 

• I/O + Cellular – Opens I/O + Cellular view. It displays the device I/O port status, and 
GSM,GPRS connection status 

• Stop Watch – Opens Stopwatch view. Use it to measure the time elapsed between 
responses, events displayed by the Terminal view 

• Settings – Opens the Settings window. Use it to configure and customize certain 
features of the Workbench interface and application 

• Help – Opens Help view. Use it to load and view help documentation 

• Login – Currently no function 

• Sync – Currently no function 
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Workspace 
Workspace displays the opened views which are used to connect to, configure, and evaluate the 
target device. 

 
Figure 4-3: Workspace Views  

Connection View 
The Connection View provides schematic connections for setting up relationships among views.  

 
                Figure 4-4: Connection View 
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5. Establishing a Connection 
The Workbench application allows you to establish a serial connection with Lantronix devices. 

Connect the device to your PC via a serial to USB cable or Bluetooth depending on interface the 
device supports. For more information to make a serial or Bluetooth connection, refer to the 
Promotion Kit User Guide of the device (see chapter 2. Related Documents). 

To establish serial communication with the device: 

1. Go to Plugins > Port or click the Port icon on the toolbar. Portview 1 displays in the 
workspace and Portview 1 circle displays in the Connection View (see figure below). 

 
     Figure 5-1: Workbench Interface with Port View  

2. Set values for all the Portview components as follows: 

• Port type – SERIAL 
• Port - Select the port to which the device is connected (go to Device Manager > 

Ports > USB Serial Port (COMxx), where xx is the COM port to use) 
• Baud – 115200 bps 
• Data bits – 8 
• Parity – None 
• Stop bit – 1 
• Flow Control – None 

3. Turn on the device and click the  icon on Portview to establish serial connection and 
start communication with the device. 

4. Go to Plugins > Terminal or click the Terminal icon on the toolbar. Terminal 1 displays 
in the workspace and Terminal 1 circle displays in the Connection View. 

5. Right-click the Connection View to enlarge it and click the Serial Port circle. The circle 
turns green establishing a connection between the Terminal View and the device, and 
the Terminal View begins to display messages from the device. See image below. 
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                            Figure 5-2: Terminal View displays messages 
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6. Views 
The Workbench Views allow you to connect to the device and perform functions related to the 
device. The Connection View shows the schematic connections between the views and the target 
device. 

To open a view, go to Plugins menu and select the required plugin option or click the view icon on 
the toolbar. The Workspace displays the view, and this view is displayed as a circle in the 
Connection View. 

Using the views requires that you have established connection with a target device (see chapter 
5. Establishing Connection). The target device is represented by the Serial Port circle. 

To establish connection between a view and the device: 

1. Open the view. 

2. Right-click the Connection View to enlarge it and click the Serial Port circle. 

3. The circle turns green establishing a connection between the view and the device. 

The figure below shows the Terminal view connected to the device: 

 
Figure 6-1: Terminal View connected to Device 
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Port View 
The Port View allows you to establish different types of communication channels with a target 
device/server.   

 
Figure 6-2: Port View 

The table below lists the Port View icons and their functions: 

Icon Function 

 

Opens the selected port/connection 

 

Closes the selected port/connection. 

 

Removes the selected port/communication from the Port-view 

 

Displays the total incoming data, in bytes since opening the port 

 

Displays the total outgoing data, in bytes since opening the port 

Table 6-1: Port View icons  

Click in the Type field of the Port View to display the different communication types. 

 
Table 6-2: Port View Types 

SERIAL 
Allows you to establish a serial communication channel between your PC and the device. 

Select Port View Type as SERIAL and enter the required values for all the Port View fields. See 
image below. 
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               Figure 6-3: SERIAL 

Field Description 

Port COM port number. Select COMxx, where xx is the port number to which device is 
connected 

Baud COM port speed. Select the same baud rate as the target device. Default baud rate for 
FOX3 is 11500 bps  

Data COM port data bits. Select 8 

Parity COM port parity. Select None 

Stop bit COM port stop bits. Select 1 

Control COM port flow control. Select None 

DTR on COM port DTR line (checked=On, unchecked=Off). 

RTS on COM port RTS line (checked=On, unchecked=Off). 
Table 6-3: Port View Fields for Serial 

UDP_CLIENT 
Allows you to establish a UDP connection with a device/server where your PC is the UDP client. 

Select Port View Type as UDP_CLIENT and enter the required values for all the Port View fields.  

 
Figure 6-4: UDP_CLIENT 

 

Field Description 

Server IP address of the device/server 
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Field Description 

Port Port number of the device/server 

Table 6-4: Port View Fields for UDP_CLIENT 

UDP_SERVER 
Allows you to establish a UDP connection with a device/server where your PC is the UDP server. 

Select Port View Type as UDP_SERVER and enter the required values for all the Port View 
fields.  

 
Figure 6-5: UDP_SERVER  

Field Description 

Server IP address of your PC 

Port Port number to listen to the incoming connection 

Table 6-5: Port View fields for UDP_SERVER  

TCP_CLIENT 
Allows you to establish a TCP connection with a device/server where your PC is the TCP client.  

Select Port View Type as TCP_CLIENT and enter the required values for all the Port View fields. 

 
Figure 6-6: TCP_CLIENT  

Field Description 

Server IP address of the device/server 

Port Port number of the device/server 
Table 6-6: Port View fields for TCP_CLIENT  

TCP_SERVER 
Allows you to establish a TCP connection with a device/server where your PC is the TCP server. 

Select Port View Type as TCP_SERVER and enter the required values for all the Port View 
fields. 
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Figure 6-7: TCP_SERVER 

Field Description 

Server IP address of your PC 

Port Port number to listen to the incoming connection 

Table 6-7: Port View fields for TCP_SERVER  

SSH_CLIENT 
Allows you to establish an SSH connection with device/server where your PC is the SSH client. 

Select Port View Type as SSH_CLIENT and enter the required values for all the Port View fields. 

 
Figure 6-8: SSH_CLIENT  

Field Description 

SSH URL IP address of the device/server 

Port Port number of the device/server 

User Username 

Password Password 
Table 6-8: Port View fields for SSH_CLIENT  

API_D2SPHERE 
Allows you to establish connection with a device that is registered on and added to d2sphere 
server.  

Select Port View Type as API_D2SPHERE and enter the required values for all the Port View 
fields. 
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Figure 6-9: API_D2SPHERE  

Field Description 

API URL URL/IP address of the d2sphere server 

User Username to login to d2sphere server 

Password Password to login to d2sphere server 

DeviceIMEI Device IMEI 
Table 6-9: Port View fields for API_D2SPHERE   

API_PERCEPXION 
Allows you to establish connection with a device that is registered on and added to Lantronix 
Percepxion server.  

Select Port View Type as API_PERCEPXION and enter the required values for all the Port View 
fields. 

 
Figure 6-10: API_PERCEPXION  

Field Description 

API URL URL/IP address of Percepxion server 

User Username to login to Percepxion server 

Password Password to login to Percepxion server 

Portal Percepxion portal name 
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Field Description 

Tenant Percepxion tenant name 

Device ID Percepxion device ID of the device 

Table 6-10: Port View fields for API_PERCEPXION  

Terminal View 
The Terminal View performs the following functions: 

• Displays the GPS data, debug information (if enabled) received from the device 
periodically every second and allows you to monitor, evaluate this data 

• Allows you to send messages/commands to the device 

• Displays the responses to all the commands executed by the device and the events 
generated by the device in response to the commands 

Open Terminal View and use Connection View to connect it to the Serial Port. The Terminal View 
begins to display messages from the device. See image below. 

 
                              Figure 6-11: Terminal View 

The table below lists the Terminal View icons and their functions: 

Icon Function 

 Change to binary - Changes the format of the Terminal display form text (default) to binary. 
Incoming protocols/messages are displayed in binary format 

 Stop - Pauses the display of further incoming messages. Use to read and copy specific 
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Icon Function 

data received from the device 

 Restarts displaying messages 

 Clear Console - Clears the contents of the Terminal View 

 Filter incoming - Enables/disables filtering for all incoming data (data sent from the device) 

 Filter outgoing - Enables/disables filtering for outgoing data (data sent to the device) 

 

Select filter type - Specifies how filter expressions are applied to the incoming/outgoing 
data: 

• Simple filter (default) - Displays all messages containing the specified text. 
• Regular expression filter - Displays all messages containing the specified 

expression. 

 Maximize console – Maximizes the Terminal View 

 Close Console – Closes the display 

Table 6-11: Port View icons and their functions 

 

Sending Messages/Commands to the Device 
The Terminal View allows you to send messages/commands to the device. 

To send a message/command to the device: 

1. Click in the text box at the bottom left corner of the terminal. See image below. 

 
Figure 6-12: Terminal View Text Box 

2. Type the command (without $ character) and press Enter key on your keyboard. All 
messages sent to the target device will be shown in the bold font.  

3. You can send commands in the following formats: 

• HEX - Automatically converts the typed text into HEX value 
• PFAL - Adds the text "PFAL," at the beginning of each command 
• CRC - Adds the checksum at the end of each command 
• CR - Adds a Carriage Return to each command 
• LF - Adds a Line Feed to each command 
• Flow – Updates the view by time and does not wait for CRLF in the data. It will 

be used by binary or stream data. 
4. Use the checkbox next to a format to select it. 

Note: To send a PFAL command to the target device, refer to 2. Related Documents [1]. 

 



  6:  Views 

Workbench User Guide 20 

Filtering Messages 
Terminal View allows you to filter the displayed messages and display only the messages that 
meet the filter criteria set by you. 

To enable filtering: 

1. In the Filter: text box, enter the text/expression that the messages must contain for them 
to be filtered and displayed.  

2. Click  icon to start filtering messages. 

Example: If you want to view only "GPRMC" protocol in the Terminal, then enter 
"GPRMC" on the input field next to this button and the Terminal displays only "GPRMC" 
protocol each second. If you want to view only system events, successes, and errors type 
"EVENT|SUCCESS|ERROR" (without spaces) on the input field next to this button. To 
apply multiple extensions to your filter, separate them using a pipe "|" 

3. Click <Add Filter> to add a child filter. You can add multiple filters. 

Each child filter terminal displays messages containing the filter text/expression in its 
Filter: text box. See image below. 

 
Figure 6-13: Terminal View with Child Filter 

4. To turn off filtering remove the text from Filter: text box or click  icon. 
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Editor View 
The Editor view allows you to perform the following functions: 

• Read the current device configuration 
• Modify the current device configuration 
• Save the device configuration to a file 
• Upload a configuration file to the device 
• Delete settings from a configuration parameter 

Open Editor View and use the Connection view to connect it to the Serial Port. 

 
Figure 6-14: Editor View 

The table below lists the Editor View icons and their functions: 

Icon Function 

 Open new editor - Add a new Editor window. 

 

Open configuration file - Opens a windows dialog box for selecting and opening *conf│.txt 
configuration files. The selected file must contain PFAL commands and not simply text. 
However, the workbench is delivered with different configuration files which are available in 
the /Lantronix Workbench/data/device configuration/*.config. These files can be 
changed and used for further configuration purposes 

 
Start sending configuration - Uploads the selected file to the target device. Each line is 
read and sent as a separate command. When the first command is successfully transmitted 
and responses are received, it skips to the next line of the file.  

 
Read user configuration - Shows user configuration setting including all configuration 
settings changed and executed by the user. Excludes factory preloaded configuration 
settings. 

 Read current device configuration - Reads the current device configuration. 
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 Clear the current editor - Clears the contents of the current editor. 

 
Save current editor content - Saves the contents of the current editor to a file when used 
for the first time for that editor. When used again for the same editor, it overwrites the 
contents of the editor. 

 Save current editor content as - Saves the contents of the current editor to a file.  

 Cut selection - Cuts and copies the selected text to the clipboard. 

 Copy selection - Copies the selected text to the clipboard. 

 Paste - Pastes all text currently on the clipboard back to the location of the insertion point on 
the editor. 

Table 6-12: Editor View Icons  

The following Editor View fields perform specific functions related to the configuration commands: 

 
Figure 6-15: Editor View Fields 

• PFAL - When enabled treats all commands as PFAL commands. You do not have to add 
$PFAL to the command 

• CRC - Enables/disables adding the checksum at the end of the response for each sent 
command (optional) 

• Append Command ID - When enabled the response to each command displays a 
unique id. If you add an id to the PFAL command, it returns an error message. When 
disabled you can add an id to your PFAL command, and the response displays the id you 
have entered 

• Retry - Number of times to retry if a command does not respond (Optional. Sets a retry 
schedule for each command that does not respond, and not for commands that respond 
with ERROR or OK). 

• Delay - Specifies the amount of time (in milliseconds) to wait for a response from the 
device and time between delivery attempts (Optional. This process continues until the 
total number of retries have been completed.) 

• Loop – Enables to execute the contents of the Editor line-wise repeatedly, based on the 
value assigned to Delay option. To send a command repeatedly, right-click over the 
command and select Loop "PFAL Command". To stop it click Stop icon that appears on 
the Editor-toolbar when Loop function is executed. 

Note:  

• To prevent any interference between old and new alarms, it is recommended to set the 
device into the Configuration Update Mode before sending any configuration to the 
device. To set the device into the Configuration Update Mode use the command: 
$PFAL,Sys.Device.CfgUpdateMode. 

• For the description of the parameters used in the device configuration and information 
about the PFAL commands, Events and States, refer to 2. Related Documents [1]. 

Editor uses five different text colors to display the configuration information. To modify the default 
colors used by the Editor, refer to chapter 8. Workbench Settings 

The below table lists the default text colors used by the Editor and the type of information for 
which they are used: 
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Color Description 

Grey For block or single comments. 

Black For commands still not transmitted. 

Blue For PFAL Command sent successfully. Device has acknowledged that 
command with OK. 

Red 
For PFAL Command that has responded with Error, or it has not responded 
within the specified delay time. To get more details, move the mouse pointer 
over the red-marked commands and pause momentarily. 

Green Comments 
Table 6-13: Editor View Text Colors  

History View 
The History View enables you to download all or a part of GPS data that has been saved inside 
the target device. The number of times data is saved inside the device depends on the user 
defined save parameter conditions (e.g., when a timer of 20 seconds expires and the speed is 
greater than 50km/h, save current position of the device). You can save the downloaded data to a 
file, convert the binary data into the NMEA format and upload the file to a mapping software to 
graphically represent the driven road. 

To save GPS data and other information inside the device use the PFAL command 
"$PFAL,GPS.History.Write,xx,"user text". 

You have the option to download the entire GPS data saved in the device or part of the data. 

Open History View and use the Connection View to connect it to the Serial Port. 

 
                       Figure 6-16: History View 

History View provides the following formats in which you can download and store the data: 

• Binary - Downloads and stores the history data to the specified file in binary format 

• Binary -> Convert - Downloads and stores the history data to the specified file in NMEA 
format. 

• Txt - Downloads and stores the history data to the specified file in .txt format 

• RMC - Generates an RMC protocol for each entry available in the history and then 
downloads and stores this data to the specified file in NMEA format. This file with RMC 
protocol can then be uploaded and plotted on a mapping software. 

• KML – Downloads and stores geographic data to the specified file in KML format. 

• User - Downloads and saves only the user text to the specified file.  
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When the download process starts a progress bar at the bottom of this view will show the status 
of the download. 
To download the entire GPS data stored in the device: 

1. Open History View. 

2. Connect the History View to the device through Connection View. 

3. Select Download all. 
4. Select required History Format. 
5. Click Download, the Save in Windows dialog box displays. 

6. Enter a file name and select .txt for Save as type field. Click Save. 

7. Once the file is successfully downloaded a success message displays and in case the 
download fails, Error while downloading history data displays. 

To download part of the GPS data saved in the device: 

1. Disable the Download all option. The Start and Stop buttons showing the current date 
and time display. 

 
                 Figure 6-17:History View to download part of GPS data 

2. Click Start field, the Select startpoint window displays. Click Stop field, the Select 
endpoint window displays. Use both options to set the duration for which you require the 
saved GPS data.    

        
Figure 6-18: Select Start Point and End Point 

3. Click Download, the Save in Windows dialog box displays. 

4. Enter a file name and select .txt for Save as type field. Click Save. 
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5. Once the file is successfully downloaded a success message displays and in case the 
download fails, Error while downloading history data displays. 

Note: 

• The option Save converted data has currently no effect on the download process. It is 
kept free for future use. 

• If the Stop-date is found, but the Start date is not, all GPS data stored earlier than the 
Stop-date will be downloaded. 

• If the download process fails (the device does not response within 15 seconds after 
starting the download), the error message Error while downloading history data displays. 

Firmware View 
The Firmware View allows you to upgrade the firmware of the device.  

Workbench application provides the following options to upgrade device firmware: 

• Locally via Bluetooth or serial to USB connection. This method is easy, fast, and reliable.  
• Remotely via a TCP connection, when local access to the device is not possible.  

Firmware upgrade via Bluetooth or Serial to USB Connection 
To upgrade firmware via Bluetooth or serial to USB connection: 

1. Open Firmware View and use Connection View to connect it to the Serial Port. 

 
                        Figure 6-19: Firmware View 

2. Select the required values for all the fields: 

• Packet size [byte] - Determines the number of bytes that will be sent in one 
packet. Min=512 bytes; Max=4096 bytes. The lower the packet size, the more 
secure is the packet transmission. The higher the packet size, the faster is the 
packet transmission. Set it to maximum (4096 bytes) for high-volume data 
transmission. If the Total retries increases, decrease the packet size 
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• Timeout [ms] - Specifies duration to wait for pending packets before trying to 
send it again. Set it to maximum (9000 ms) 

• Maximum retries - Determines how many times a packet should be resent if the 
target device does not respond with SUCCESS within the timeout. Set it to 5 

• Maximum slots - Determines how many packets should be sent at once. This 
setting is device dependent. Set it to 5 

• Transmission channel – Select SERIAL 
3. Click Browse to locate and add the firmware upgrade (.frp) file. 

 
                     Figure 6-20: Firmware Upgrade File 

4. Click icon to start the firmware upgrade. 

Firmware upgrade via TCP Connection 
To upgrade firmware remotely via TCP server, refer to chapter 2. Related Documents [6]. 
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GPS View 
GPS View graphically displays the location of the device, the signal strength and orbital position 
of each of the tracked, used, and available satellites.  

Open a GPS View and use the Connection View to connect it to the Serial Port. The GPS View 
begins to display information. See image below. 

 
                Figure 6-21: GPS View 

The GPS view shows three different characteristics for evaluating GPS performances such as 
Signal Strength, GPS Details, and Orbital Position. 

Lantronix Advanced Configuration Service (LACS) View 
Allows you to get device information and functions as a chatbot for configuration requests. 

Note: LACS is currently in use for internal purposes only. 
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Wizard View 
Allows you to configure your device for different functions and automatically generate device 
configuration (PFAL Commands) for each function based on your input. 

You can use any of the following options to open Wizard View: 

• Start the Workbench application and in the Load Profile dialog box that displays, set 
Profiles field to Default Wizard Mode, and click OK. The Workbench UI displays with 
Wizard View open. 

 
Figure 6-22: Default Wizard Mode 

 
Figure 6-23: Workbench UI with Wizard View Open 

• In the Workbench UI select Wizard from the Plugins menu options or click the Wizard 
icon on the toolbar. The Wizard View displays with information about the ConfigWizard 
and its features. 
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Figure 6-24: Wizard View 

To use the Wizard View: 

1. Open the Wizard View and on the home page click Next. The Device Discovery page 
displays.  

This page allows you to select how the ConfigWizard detects the connected device. The 
Manual discovery (advanced) option is selected by default (currently this is the only 
option available). 

 
Figure 6-25: Device Discovery Page 
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2. Click Next, the Manual device discovery page displays. 

This page allows you to select the communication channel you want to use to connect to 
the device. The Device is connected to a serial port option is selected by default 
(currently this is the only option available). 

 
Figure 6-26: Manual Device Discovery Page 

3. Click Next, the Serial port selection page displays. 

 
Figure 6-27: Serial Port Selection Page 

4. Click in the Port field and select the port to which the device is connected. 

5. Click Continue, the Automatic device detection page displays. The Device field 
displays the name of the connected device. 
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Figure 6-28: Automatic Device Detection Page 

6. If the right device is detected click Proceed and the Configurator page displays. If not, 
you can go back and check the port or click Manual, the Manual device selection page 
displays. 

 
Figure 6-29: Manual device selection page 

7. Click in the Device field and select the required device from the dropdown.  

8. Click Next, the Configurator page displays. 
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Figure 6-30: Configurator page 

The Configurator page allows you to configure the functions of the device related to: 

• Connectivity 
• Power Mode 

Connectivity 
Allows you to generate configuration for connectivity related functions of the device. On the 
Configurator page, click Connectivity. The function of the connectivity feature displays. Click 
the arrow pointing to Connectivity, the following options display: 

• APN Setup 
• TCP Server Setup 
• Percepxion Setup 

 
Figure 6-31: Connectivity Options 
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APN Setup 
Allows you to manually configure the access point name (APN) based on your service provider. 
This configuration enables the device to establish GPRS/data connection. 

To configure APN Setup: 

1. Click APN Setup, the different fields display. 

 
Figure 6-32: APN Setup 

2. Place the cursor over each parameter to view its function. 

3. Select or enter the required value for all the fields. 

4. Do one of the following: 

• Click Generate to save the configuration file on your system. 
• Click Update to send the configuration to device. 

To generate the configuration file: 

1. Click Generate, the Save as Command Template window displays. 

 
Figure 6-33: Window to save Configuration File 
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2. Click the Save as checkbox and then enter the File Name and select the File Format. 

 
Figure 6-34: File Name and Format of the Configuration File 

3. Click OK to save the configuration file to your local system.  

TCP Server Setup 
Your device can establish multiple TCP connections.  The TCP Server Setup allows you to 
configure your device to establish TCP connections with two servers 

To configure TCP Server Setup: 

1. Click TCP Server Setup, the different fields display. 

 
Figure 6-35: TCP Server Setup 

2. Place the cursor over each parameter and option to view its function. 

3. For the fields TCP Client 1 and TCP client 2, enter the IP address or DNS of the 
respective TCP server and the port number to use in the format displayed. 

4. Click in the checkbox for each option to enable it and then set the required value. 
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5. Click Generate or Update. 

Note: For further details on Send Modes refer to PFAL Command Reference (see chapter 2. 
Related Documents). 

Percepxion Setup 
Allows you to configure the device to establish connection with Lantronix Percepxion server. 

To configure Percepxion Setup: 

1. Click Percepxion Setup, the different fields display. 

 
Figure 6-36: Percepxion Setup 

2. Place the cursor over each option to view its function. 

3. Click in the checkbox for each option to enable it and then set the required value. 

4. Click Generate or Update. 

Power Mode 
Allows you to configure the settings depending on which the goes into sleep mode or wakes up. 
On the Configurator page, click Power Mode, the function of the Power Mode feature displays. 
Click the arrow pointing to Power Mode, the following options display: 

• Power Setup 
• Sleep/wake 
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Figure 6-37: Power Mode Options 

Power Setup 
To configure Power Setup: 

1. Click Power Setup on the Configurator page, the different fields display. 

 
Figure 6-38: Power Setup 

2. Place the cursor over each option to view its function. 



  6:  Views 

Workbench User Guide 37 

3. Click in the checkbox for each option to select it and then set the required value. 

4. Click Generate or Update. 

Note: For further instructions on how to use Power Setup options refer to PFAL Command 
Reference (see chapter 2. Related Documents). 

Sleep/Wake 
To configure Sleep/Wake: 

1. Click Seep/Wake on the Configurator page, the different fields display. 

 
Figure 6-39: Sleep/Wake Settings 

2. Place the cursor over each option to view its function. 

3. Click in the checkbox for each option to select it. 

4. Click Generate or Update. 

Note: For further instructions on how to use Power Setup options refer to PFAL Command 
Reference (chapter 2. Related Documents). 
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Recorder View 
Recorder View allows you to log all information received from the target device to a log file and 
load it back later for evaluation purposes. It also allows you to filter the required data from the log 
file. The Recorder View has a Logger section and a Player section. 

Logging Data 
To log data: 

1. Open the Recorder and use the Connection View to connect it to the Serial Port. 

 
                     Figure 6-40: Recorder View 

2. Click the  icon and enter the location where you want to save the log file. 

3. The Log file field displays the complete path of the location containing the log file. 

4. Enter the filter text for the data in the Filters field and click the  icon to enable/disable 
filtering. 

5. Check the Add timestamp to the logged lines. checkbox to add a timestamp to 
timestamp (PC local time) to each record/data being saved into the log file. 

6. Check the Log RXTX. checkbox to mark each record into the log file as RX for incoming 
data or TX for outgoing data, for easy identification during playing. 
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                   Figure 6-41: Logging Data 

7. Click the  icon to start logging data. The File Size: and Number of Lines: values keep 
updating, indicating that data is being logged. 

The table below lists the buttons of the Recorder View Player and their function: 

Button Function 

 record - Starts/stops logging data into the log file 

 play - Starts playing the file based on the specified Delay between lines interval 

 stop - Stops logging data into file while logging data. Stops playing when playing a file 

 pause - Pauses logging or pauses playing depending on when used 

 step forward - Selects the next line in the file 

 step backward - Returns to the previous line in the file. 

 back - Starts playing the selected file backward. 

 rewind - Plays the file backward (rewind), faster than back button 

 fast forward - Plays the file forward faster than play button. 

The Delay between lines field sets the delay time, in milliseconds, between playing two records 
(default 1000 ms). 

Playing Data 
To play data logged in a file: 

1. Open a Terminal View and use the Connection View to connect it to the Serial Port. 

2. Open the Recorder and use the Connection View to connect it to the Terminal View. 

3. Click the  icon and load the log file. 
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4. Click icon to start playing the logged data. 

5. The data is displayed in the Terminal View (starting with TX). 

 
Figure 6-42: Playing Logged Data 
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I/O + Cellullar View 
I/O + Cellular View shows the I/O port status the device supports, GSM and GPRS connection 
status, signal quality, and the name of the GSM network provider. All values shown on this view 
are taken from the GPIOP and GSM protocol. If these protocols are switched off, no data will be 
displayed. 

Open the I/O + Cellular View and use the Connection View to connect it to the Serial Port. 

 
Figure 6-43: I/O + Cellular View 

The table below lists all the I/O + Cellular View fields and their description: 

Field Description 

Digital 

IN Indicates the current status of the digital inputs (if supported by the connected device) 
Checked = High, Unchecked = Low 

OUT Indicates the current status of the digital outputs (if supported by the connected device) 
Checked = active; Unchecked = unactive 

IGN Indicates the current status of the ignition line (if supported by the connected device) 
Checked = High, Unchecked = Low 
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Field Description 

Charg. Indicates the current status of the internal battery (if supported by the connected device) 
Checked = Charging, Unchecked = Not charging 

Analog 

IN 1 Shows the current voltage value on the analog input 1 (if supported by the connected device) 

IN 2 Shows the current voltage value on the analog input 2 (if supported by the connected device) 

IN 3 Shows the current voltage value on the analog input 3 (if supported by the connected device) 

IN 4 Shows the current voltage value on the analog input 4 (if supported by the connected device) 

Power ext. Shows the current input voltage of the external power supply 

Power bat. Shows the current voltage of the internal battery 

GSM 

Signal Shows the GSM signal strength 

Provider Shows the GSM provider name 

GPRS 
Shows the GPRS current state.  
Unknown - double-click to refresh 
Disabled - GPRS not available 
Connected/Disconnected 

Table 6-14: I/O + Cellular View Fields 

Stop Watch View 
The Stop Watch View allows you to measure the time elapsed between required messages 
displayed by the Terminal View. 

To use the Stop Watch View: 

1. Open Terminal View and use the Connection View to connect it to the Serial Port. 

2. Open Stop Watch View and use the Connection View to connect it to the Serial Port. 

 
                Figure 6-44: Stop Watch View 

3. You can measure the time elapsed between required messages by using the Start and 
Stop buttons. Click Reset to reset clock. 
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To automatically measure the time elapsed between required messages: 

1. In the StartExp. field enter the expression to start the timer when displayed by the 
Terminal View. 

2. In the StopExp. field enter the expression to stop the timer when displayed by the 
Terminal View. 

3. Check the ScanData checkbox to start the timer. 

4. In the ResetExp. field enter the expression to reset the timer when displayed by the 
Terminal View 

Help View 
Help View provides documentation to help you use the Workbench application and other user 
documents related to FOX3 and BOLERO40 series devices. 

Open the Help View to load the Workbench User Guide.  
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7. Profiles 
A profile is a collection of workspace views and connections. The Workbench provides built-in 
profiles and allows you to save custom profiles. 

Saving a User Profile 
To save a profile: 

1. Click File > Save profile. 

2. The Save profile dialog box displays. Enter a profile name in the Profiles field and click 
OK.  

Loading a Profile 
To load a profile: 

1. Start the Workbench application. The Load profile dialog box displays. 

2. Click in the Profiles window, the dropdown displays the profiles.  

3. Select the required profile and click OK, the profile displays. 

Overwriting a User Profile 
Once you load an existing user profile and make changes, to only save the current contents of 
the workspace (overwrite the profile) click File > Save profile.  

Note: If you want to retain the original contents of the profile click File > Save profile as and 
save the current contents of the workspace as a new profile. 
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8. Workbench Settings 
The Workbench Settings allows you to configure and customize the Workbench interface. To 
access Workbench Settings, go to File > Settings. The Workbench Settings window displays. 
Figure 8-1 below shows the Workbench Settings window with available options. 

 
                             Figure 8-1: Workbench Settings 

Console 
Console allows you to configure the characteristics of the contents displayed by Terminal view. 
Click Console, the following options display (see Figure 8-1): 

• Colors 
• Other Settings 

Colors 
Colors allows you to set the text color for the different categories of messages displayed in the 
Terminal View.  

To set Colors: 

1. Click Colors, the below window displays.
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Figure 8-2: Colors Setting 

2. Click Actions, the different color options display as shown below. 

 
                  Figure 8-3: Color Options 

3. Select the required color or click Define Custom Colors to create a custom color. 

4. Once you select the color, click OK. All ACTION messages will now display in the 
selected color. 

5. Similarly select colors for the different message categories shown in Figure 8-2. 

Other Settings 
Other Settings allows to configure the Terminal view properties shown in Figure 8-4. 

To configure Other Settings: 

1. Click Other settings, the below window displays. 
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                                        Figure 8-4: Other Settings 

2. Enter the required values for all the Content fields in the above figure.  

3. Click Fonts to display the Font window. Select the required font settings and click OK to 
apply the selected values. 

 
                           Figure 8-5: Font Window 

4. Click OK on Workbench Settings window to apply the selected values. 
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Editor 
Editor allows you to configure the characteristics of the contents displayed by Editor view. 

To configure Editor: 

1. Click Editor and the Colors window displays as shown in Figure 8-1 

2. Click Colors, the below window displays: 

 
                                                          Figure 8-6: Editor Colors 

3. Click a message category in the above image and the color options display. Set a color 
for that message category (similar to 8.1.1.). All messages that belong to this category 
are displayed in the selected color. 

4. Similarly set colors for all the available message categories. 
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General Settings 
Click General Settings, the following fields display as shown in Figure 8-1: 

• Appearance 
• Connection Manager 
• Startup 
• Shutdown 

Appearance 
Appearance allows you to configure monitor settings.  

To configure Appearance: 

1. Click Appearance, the below window displays: 

 
Figure 8-7: Appearance settings 

2. Set the required values and click OK. 

Connection Manager 
Connection Manager allows you to configure the properties of Connection View.  

To configure Connection Manager: 

1. Click Connection Manager, the below window displays: 

 
Figure 8-8: Connection Manager Settings 

2. Set the required value and click OK. 

Startup  
Startup allows you to configure the application behavior during the startup process.  

To configure Startup: 

1. Click Startup, the below window displays. 
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Figure 8-9: Startup Settings 

2. Enable or disable autosaving as required. 

3. Click OK to save the setting. 

Shutdown 
Shutdown allows you to configure application behavior during shutdown process.  

To configure Shutdown: 

1. Click Shutdown, the below window displays. 

 
Figure 8-10: Shutdown settings 

2. Enable or disable the options as required. 

3. Click OK to save the settings. 
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Profile Manager 
Profile Manager allows you to configure the properties of the saved profiles and the options to 
load profiles during startup.  

To configure Profile Manger: 

1. Click Profile Manager, the Profiles option displays. Click Profiles, the below window 
displays: 

 
Figure 8-11: Profiles Settings 

2. Enable, disable the available options as required.  

3. Provide names and descriptions for the saved profiles.  

4. Click Browse and select a location on your PC for Current Location. The user profiles 
are saved in this location. 

5. Click OK to apply the settings. 
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